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ABSTRACT

The traditional HSC Chemistry software was desigieedsarious simulation and modeling
applications based on independent chemical reactod process units. The new HSC-Sim
module expands the possibilities for applying HSt@istry to a whole process made up of
several process units and streams.

The HSC-Sim module consists of graphical flowsheetl spreadsheet type process unit
models. The custom-made variable list makes itips$o create many different types of
process models in chemistry, metallurgy, mineralagonomics, etc. Each process unit is
actually one Excel file. The HSC AddIn functions ymae used to turn these independent
calculation units into small HSC engines for thedymmamic applications.

The process model created using the HSC-Sim flogisimodule consists of one FLS file
with a graphical flowsheet and one XLS file for legarocess unit. These process files are
always saved in the same file folder. The XLS fgestain the calculation model of the unit,
and these XLS-models may be reused in the otheepses.

The target in HSC-Sim development has been toeeatmple but still powerful simulation
tool for the ordinary process engineer. If the usan use traditional HSC Chemistry and
Excel software then he/she should be able to sxethé new HSC-Sim module. The HSC-
Sim module also has high quality and versatile lgicgpcapabilities and visualization. For
example, HSC-Sim module has built-in "Sankey diagrato visualize the distribution of
the elements and process variables.

The HSC-Sim module also contains other sub modoéssdes the HSC-Sim Flowsheet
module: however, this manual focuses only on th€+$8n Flowsheet module.



27.

Excel Add-In Functions

I&W Technology HSC Chemistry ® 6.0 40 - 4(74)

Antti Roine, Jarkko-Mansikka-aho August 14, 2006 06120-ORC-T

Tuukka Kotiranta, Peter Bjorklund

Pertti Lamberg

CONTENTS
40 HSC-Sim Flowsheet module 5
40.1 Brief Step-by-Step Start-up 7
40.2 HSC-Sim Basic Settings and Operations 9
40.2.1 HSC-Sim Specifications 9
40.2.2 Graphical Flowsheet Settings 11
40.2.3 Calculation Model Editor Settings 12
40.2.4 HSC AddIn Functions 13
40.2.5 Specification of the Drawing Area 14
40.2.6 Creating a Process Folder 14
40.2.7 Saving Files 15
40.3 Graphical User Interface 15
40.3.1 Toolbars and Menus 17
40.3.2 Properties / Process Toolbar 18
40.3.3 Properties / Drawing Toolbar 19
40.3.4 Properties / Units Toolbar 20
40.3.5 Drawing Toolbar (In Draw menu) 22
40.3.6 Rotate / Flip Toolbar (in Arrange menu) 23
40.3.7 Order Toolbar (in Arrange menu) 23
40.3.8 Combiner Toolbar (in Arrange menu) 23
40.3.9 Size Toolbar (in Arrange menu) 23
40.3.10 Alignment Toolbar (in Arrange menu) 24
40.3.11 Notes Toolbar 24
40.3.12 File Links Toolbar 24
40.3.13 Standard Toolbar (in File and Edit menu) 24
40.3.14 Tools Menu Selection 25
40.4 Drawing Flowsheets 27
40.4.1 Editing of Drawing Objects 31
40.4.2 Editing Unit Images 32
40.5 Creating a Variable List 33
40.6 Creating Calculation Models 39
40.6.1 Creating Distribution Model 40
40.6.2 Creating Reaction Equation Models 42
40.6.3 Creating Equilibrium Models 45
40.7 Specifying Raw Materials 47
40.8 Running Simulation 49
40.8.1 Visualize Settings Dialog 53
40.9 Printing 54
40.10 Element Balances of the Units 55
40.11 List of Streams - Variable Balances 56
40.12 Creating Controls 57
40.13 Remote Control - Scenarios - Sensitivity 60
40.14 Creating Reports 61
40.15 Global Cell Editor 62
40.16 Calculation Model Appearance and Format 63
40.17 Density of Aqueous Solutions 64
40.18 Password Protection of Units 67
40.19 Data Reconciliation 68



I&W Technology HSC Chemistry ® 6.0 40 - 5(74)

Antti Roine, Jarkko-Mansikka-aho August 14, 2006 06120-ORC-T
Tuukka Kotiranta, Peter Bjorklund
Pertti Lamberg

40. HSC-Sim Flowsheet module
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Fig. 1: HSC-Sim main user interface with flowsheet drayvamd process calculation tools.

Most of the HSC Chemistry modules have been madethfe simulation of chemical
reactions in a single process unit. The new HSC+8wmdule extends the scope to a whole
process made up of several process units. The Sidule uses two main user interfaces: a
graphical flowsheet interface (Fig. 1) and behiadheprocess unit a spreadsheet type Model
Editor interface (Fig. 2). The basic ideas of tim Sodule are quite simple:

1. The process consists of the process units whick haen connected to each other with
streams, Fig. 1. The flowsheet is saved in one fiteS

2. Behind each process unit there is a "small HSCrerighade of an Excel emulator with
HSC AddIn functions or other DLL-based tools, Fig.Nearly any types of model may
be created using the Excel emulator, such as claéneiconomic, biological, etc. These
models may be reused because they are saved psimudat XLS files.

3. The process unit calculation models are indepenafegrich other.

4. The streams on the graphical flowsheet specifynthéerial (= data and information)
transfer and data exchange between the process(bhf file).

5. There are two modes in the HSC-Sim modDlesigner ModeandRun Mode.

6. The user draws and edits the flowsheet in the Desigrode, which is very similar to
any other vector drawing program. In the Run (dateon) mode the graphical
flowsheet is locked.
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2. HSC-Sim Calculation Model Editor. Output sheebwh the Output streams of

Process Unit 2. Short variable list has been sieciBync modes: A)Green: variable list
within all units synchronized; B} > variable list within one unit synchronized; B¢d:
synchronization OFF.

7.

10.

The

The Calculation Module consists at least of Ingditput, Dist, Controls and Model
sheets, Fig. 2. The Input sheet contains the isppaams, the Output sheet the output
streams, the Dist sheet possible distribution \&gltlee Controls sheet possible controls,
and the Model sheet possible calculation modelg €dream always takes one column.
The user can also add 251 sheets of his own ifssacg but these must be located after
the model sheet. The format and syntax of the fimst default sheets is partially fixed.
The formats of your own sheets are free.

In Run mode the calculation procedure recalculates one by one downstream and
after each calculation transfers the data from gberce unit Output sheet to the
destination unit Input sheet, according to theasti® on the graphical flowsheet, Fig. 1.
The calculation procedure transfers the values the&o Input sheet stream columns,
therefore you cannot use formulas in these columnd,i.e. the calculation procedure
cuts any possible circular references betweentits.u

The free-form and adaptable variable list makes H®8C-Sim module extremely
flexible for any kind of simulation models in chestny, electronics, economics,
biology, etc., Fig. 3.

The user models may be created using familiar Ebezetulas and cell references. It is
not necessary to learn some cumbersome macro lgegudihe HSC Addin functions
bring thermodynamics to these models. In futureémge of AddIn functions and other
DLL-tools will be expanded.

template Model.XLS file in the HSC6 folder mg used to specify the default font,

number, color and other visual formats of the modebt like changing the style of the
mobile phone by using different covers, Fig. 2.
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40.1 Brief Step-by-Step Start-up

Yariable Type Selection for Active Row i |
R Type Marne I Measure Lnik
I 7 IA IAmuunt I tfh j
Yariable Tyvpe: Gas [ Phase Mumber:
;
Temperature T Phase 1 {i5as)
Pressure Pr Phase Z (Water)
Phase P Phase 3 (Solid)
Species Phase 4
Enthalpy H Phase 5
Mass Fraction F Phase &
Density O Phase 7
Zoncentration C Phase &
Private L Phase 2
Mineral M Phase 10
Cther O Phase 11
Yolume ¥ Phase 12
Set Format Al [[0.00 =]
Sample Yariable List | all Wisible | All Unvisible | Iv wisible in Fun Mode
Paste Lisk ko All Units | Create Formulas | Create Formulas Al |
Cloze | Set Yanable Type to All Units |

Fig. 3: Variable Type Editor. Variable type A has beelected for the active row.

The Sim module consists of versatile flowsheet dngvand process calculation tools. The
use of the HSC-Sim module should be relatively dssyause A) the drawing tools are quite
similar to any other vector drawing program, B) taéculation model tools are quite similar
to the Excel spreadsheet program procedures, farsymtax and options. The HSC-Sim
development target has been to create a simplgoyetrful simulation tool for the ordinary
process engineer.

The HSC-Sim process model consists of the flowsheet model files. These files are
always saved in the same file folder, usually lith same name as the name of the process,
see Chapter 40.2.7 Saving Files.

The following brief step-by-step list gives an id&athe main working procedures when a
new process model is created using the HSC-Sim lapdu

1. Select default measure units using Measure Uralegli see Chapter 40.5, Fig. 37.

2. Draw one unit on the flowsheet, Fig. 1, using Uadl, Fig. 4, and open Model Editor
by double clicking this unit, Fig. 2, see Chapt@rddDrawing Flowsheets.

3. Specify the process Variable list either on theutnpr Output sheet, Fig. 2. The Sync
option at the bottom must be oGreen", because it will transfer this list to all undasd
sheets. See Chapter 40.5, Creating Variable Lis. Sync mode " " means that
the variable list is synchronized only within oneituThe Sync modeRed" puts the
synchronization totally off.
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Specify variable type using the Variable Type aditog. 3. You may open Type editor
by clicking the Type label at the bottom, Fig. ZarMble type in column A is needed
only by the model and formula wizards but not bg ttalculation procedure. In
principle, if you do not use these wizards, then ylm not need to specify variable
types. Note that you may also manually write theetflag in column A. Fig. 2.

@ Excel Mode | @ Snap to Grid | @ Persist Tool  |[Zoom: 100%: |- 88, O

Fig. 4 The most important drawing tooldnit, Stream, Select Edit Stream Pointsand at
the bottom the most important drawing options @wdheet form, Fig. 1.

5.

9.

10.

11.

When you have specified all the variables and tythes® you may press the "Create
Formulas All" button in Type Editor, Fig. 3. Thislicreate default formulas in column
D, Fig. 2. See Chapter 40.5, Creating Variable. List

Draw the units and streams using the Unit and 8trdeawing tools in the Designer
mode, see Chapter 40.4. The icons of the most i@pibdrawing tools are shown in
Fig. 4. They usually locate at the top left corokthe user interface, Fig. 1.

Note that the most important option tools may betratled at the bottom of a flowsheet
form, Fig. 1. TheSnap to Grid option makes it easier to draw professional-logkin
flowsheetsPersist Toolremembers the last used drawing tool.

Save the flowsheet using the File, Save As didtg, 1.1t is recommended to create a
separate file folder for each proceSee Chapters 40.3 and 40.4 for details. It is@dg
idea to use the process name also as the foldes.riem Sim module saves all the files
in this same folder. This file-set consists of &S file with graphics and one XLS file
of each unit.

XLS files use the Excel 2000 file format. FLS filean only be opened with the Sim
module, but you may export these in other formisitste: Save the process regularly
using a different folder name or make backups @ fblder using Windows My
Computer. This makes it possible to recover thegss if there is an error. See Chapter
40.2.7.

Create the process models using the HSC-Sim Exiter end wizards onto the Model
sheet. These wizards automatically connect thetlapeams with the Output Streams
using some Excel type formulas and cell referenlege that you may also manually
create these models. See Chapter 40.6, Creatiogl@adn Models.

Start Run mode and carry out the simulation, sesp@in 40.8, Running Simulation.

In Run mode select a variable and press Visuadird, this will show the distributions
in graphical format. Chapter 40.8.

Draw, print or copy-paste the results to other Wimsl applications using Run mode
tools. Chapter 40.9.

The following chapters will give more detailed dgsiton of these steps. If you are planning
to use HSC-Sim, please read at least Chapters 40.2.,7, 40.4, 40.5, 40.6, 40.7 and 40.8.
But of course by reading all the chapters you mayeryour life easier in the long run.
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40.2

HSC-Sim Basic Settings and Operations

This chapter gives information about the genertilrgs of the Sim module. Usually you
may start using Sim without changing the defaulues, but gradually you may want to
change the default settings. HSC-Sim rememberaheelected settings using the files:

C:\HSC6\Sim_FlowSheet1.INI Drawing settings
C:\HSC6\Sim_FlowSheet2.INI Drawing interface sesn

You may delete these files if you want to recover original settings. If you have some
problems with HSC-Sim operation then deleting ethfiles and restarting may help.

40.2.1 HSC-Sim Specifications

The HSC-Sim Flowsheet module works on Windows 98, MT, 2000 and XP computers.
However, a fast processor (Pentium 4 or AMD 64, SHz) with at least 256 MB of
memory will smooth out operation a lot comparedhwitor example, some 500 MHz
processor with small memory.

The maximum drawing area is currently limited t@Q@0% 1000 mm, because some bitmap
saving routines may become slow with large drawidswever, this limitation is easily
removed. The dimensions and location units areyawamillimeters.

The X- and Y- coordinates start from the top l@itrer and end at the bottom right corner of
the drawing area. The printing area does not deparitie size of the drawing area, and any
selection may be printed and zoomed freely torfitd, A3, etc.

The maximum number of drawing objects depends enntbmory and processor capacity
available. A normal PC can easily handle some 169j@écts. Note that gradient- based
object fill styles consume a lot of processor cépatn some cases speed may be improved
by replacing vector-based (EMF) unit objects witadient fill style with bitmap unit objects
(JPG). The speed also depends on the setting€hsgxer 43.2.

Up to 32000 variables and data may be connecteddio drawing object.

Flowsheet uses its own file format which uses thiéxs*.FLS. This format saves all the
available flowsheet properties. However, many offieture file formats may also be used to
export and import pictures into the Flowsheet medul

Export file formats: Import File Formats:

AutoCAD DXF Interchange R14 (*.DXF) AutoCAD DXF Interchange R12-14 (*.DXF)
Windows Enhanced Metafile (*.EMF) Windows Enhanced Metafile (*.EMF)
Windows Metafile (*.WMF) Windows Metafile (*.-WMF)

CompuServe PNG (*.PNG) CompuServe PNG (*.PNG)

JPEG bitmap (*.JPG) CompuServe bitmap (*.GIF)

(Not Progressive JPEG) JPEG bitmap (*.JPC)

Windows bitmap (*.BMP) Windows bitmap (*.BMP)

Windows DIB (*.DIB)

The calculation unit model limits are the same asniMS Excel 2000:
- Sheets 256

- Columns 256
- Rows 65536

HSC-Sim usually retains VBA macros in XLS files,thti does not run these macros.
However, if you insert/delete sheets or renametshben VBA macros will be deleted.
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40.2.2 Graphical Flowsheet Settings

Options
B General - |
Markersize (pt) 4
HitSensitivity (pE 4
Repainkt 1 - Buffered j
MoverMode 0 - Realtime
CipenDrai 0-Ful
Scrollbars 1 - Auto —
P Cuality 70
Confirmn Deleke True
Tabskyle 0- Top Tabs
IUndo Skeps Maximum 0
E Grid
GridSkyle - Dak
GridShow 1 - Under
aridCalor I 12s; 128; 128
GridWidth 2
aridHeight z -
Repaint
Buffered (hidden refresh, smoother, slow), Narmal (visible
refresh, Flicker, Fask)
Cancel | Ampmly I I |

Fig. 5. Flowsheet settings dialog. Open this dialog usifigw, Options..." selection.

The Flowsheet module automatically saves some @@vidg settings, i.e. the program
remembers the last settings you have used. Howesttr the View, Options selection you
may manually change some of these default setttngseet your needs and preferences, see
Fig. 5. The following settings are available:

General Settings:

Marker Size
HitSensitivity
Repaint
MoveMode

OpenDraw

ScrollBars

Default Font
JPG Quality

Selection handle size (default 4 points)

Mouse pointer object detection distance (defayloihts)
Buffered (hidden refresh, smoother, slow)

Normal (visible refresh, flicker, fast)

Real Time (whole object moves, slow)

Outline (object frame moves, fast)

Full (all objects visible, slow)

Container (internal object edit possible, notse)
Hatched (only active object visible, fast)

Auto (X and Y scroll bars visible if needed)

None (no scroll bars, movement with right mousgdn)
Font name, style, size, color

Compression percentage (only for saving in JP @by

Confirm Delete Ask a confirmation for delete operations.

TabStyle
Undo Steps

Tab location in Properties Toolbar
Not in use
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Grid Settings:
GridStyle Dot (dot is used as grid marker)
Solid Line
Dotted line
Dashed Line
GridShow None (no grid)
Under (grid under objects)
Above (grid above objects)
GridColor Color of grid points
Gridwidth Distance between grid points (default 2 mm)
GridHeight Distance between grid points (default 2 mm)
SnapToGrid  Align drawing object to grid

The Flowsheet module automatically saves Flowsimeelule settings in two files:
C:\HSC6\Sim_FlowSheet1.INI Drawing settings

C:\HSC6\Sim_FlowSheet2.INI Drawing interface settings

The folder depends on your installation selectidhsse files exist in the same folder as

Sim.EXE. If you delete these files in the C:\HS©@R&Iér then the Flowsheet module uses old
default settings and automatically recreates thékBles.

40.2.3 Calculation Model Editor Settings

] -
L] v [ Input A, Output A Dist A Conirols A Model / KNI 'H
| @ Vis [ TYPE: Amount Tokal |@©®@ Sync | Temperature: °C | Pressure: bar | Enmeragy: Mcal g

|7 Sync all Uniks (Cols & - 0
Sync Ackive Unit (Cols A - 0)
Swnc OFF (= Excel Mode)

Fig. 6. Traffic lights, i.e.Sync modes: A)Green: variable list within all units synchronized,;
B) Yellow: variable list within one unit synchronized; Bg¢d: synchronization OFF.

The Calculation Model Editor has quite similar loasettings to MS Excel. You will find
these from "Format" and "Tools, Options" menus. ldeev, the Sync setting is different and
very important. TheGreen" mode is the default and this means that all véibdt changes
within all units (Input, Output, Dist sheets) argnshronized. Please use Green mode
normally. However, if you import models you may use " sync mode to arrange the
variable list in the same order as in the othetsuriView List Variables..." shows the
default variable list. InRed' mode you may edit sheets just like in Excel antheut any
locks; please be careful, in Red mode you mayyeasks up the variable list.

The Template Model.XLS file contains all the defaidrmat settings of the calculation
models. You may change format settings using MSeEand by resaving this file back in
the original locatiorC:\\HSC6\Template Model. XLS

Note: Do not insert or delete rows or columninput, Output, Dist or Controls sheets!
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40.2.4 HSC AddIn Functions

Add-Ing available: K
[JHSCH

Cancel

Browse...

Remowve

il

—HSCE
H5C & Add-ln Functionz

C:AH5CEYHSCE.DLL

Fig. 7.HSC AddIn function selection and activation dialog

HSC Addin functions are made for MS Excel and HS@-Salculation modules, i.e. these
same functions are available in both environmeHSC Addin functions contain mainly

chemical and thermodynamical functions which rehd nhecessary data from the HSC
thermochemical database.

All HSC-Sim Addin functions are located HSC6.DLL. HSC-Sim uses this file directly
but MS Excel uses it through thSC6.XLL interface. This interface is better than the old
HSC Chemistry 5 HSC5.XLA interface, because the BI3CL file path is not saved in
Excel files in the same way as the HSC5.XLA filghparhis makes HSC6.DLL Addin-
function files "mobile” and compatible.

You need to activate these functions only once gusire HSC-Sim Calculation Module

menu selection "Tools, Addin Functions...". Pleasted only the new HSC6 Addin

functions and press OK, Fig. 7. If HSC6 is misdnogn the list then browse:
C:\HSC6HSC6.DLL

You must activate these functions in the same waynaMS Excel. If HSC6 Addin is
missing from the list then browse (path may vanyateling on original installation):
C:\HSC6\AddINMSC6.XLL

Using these Addin functions you may create sopf@isdd thermochemical calculation
models in your process units. See examples in:SCWAddInsAddIinSample. XLS.

You will find a much more detailed description diese functions in Chapte27 Excel
Add-Ins.DOC" of HSC Help.
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40.2.5 Specification of the Drawing Area

Mew Process

—Drawing area
Set drawing area ko:

width: [ Fao mm A4 Portrat | A3 Portrat |

Height: 500 iy &4 Landscape I &3 Landscape I

Maoke: Print Dialog makes possible to Fit any size drawing to A4, etc.

Resolution: I 5 Points/mm {10-100)

Cancel | Ik

Fig. 8 New Process dialog clears and specifies the t@msheet drawing area.

The first step when creating a new process is pleeification of the Flowsheet drawing
canvas area. This is done using the Menu seletkid®, New...". This selection opens the

drawing canvas area dialog, Fig. 8.

Usually the default canvas area 500 * 500 mm s Qls, because in the flowsheet printing
stage any size of the drawing may be fitted or zbno A4 or any other size of paper. You
can change the drawing canvas area later on ubmgnenu selection "View, Drawing
Area...". The Resolution selection may be used toegee or decrease the number of point
per mm, the default 56 points is usually enougtréate nice flowsheets.

40.2.6 Creating a Process Folder

5 ave in: Iﬁ Process Sarnple j = ﬂ* :

Process Samnple.fls |Create Mews Folder |:

File name: Procezs Sample.flz Save I
Save as ype; ISim Flovwzheet file [*.flz] j Cancel |

Fig. 9: The "Create New Folder" tool of th&ile, Save As.." dialog may be used to create
a new folder for the new process files.

Usually one HSC-Sim process consists of severas fithich are located in the same file
folder. It is recommended to specify some namethier process at the very beginning,
because this process name may be used as the h#émeenew folder, for example, "Process
Sample" is the proper process name.
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Menu selection "File, Save As".and the "Create New Folder" tool may be used éate a
new folder, Fig. 9. This new folder may be locatedny place on your hard disk, but the
default path is: C:\HSC6\Sim\Flowsheet\

You may also create this new folder using the WimgldMy Computer” "File, New,
Folder..." Dialog.

40.2.7 Saving Files

& C:"HSC54Sim' Flowsheet',Process Sample - | I:Ilﬂ
File Edit ‘iew Favorites Tools  Help ﬁ
= Back v = - | @Search L. Folders QB | B B 5% & | [Ex|~
address | C\HSCS\SimiFlawshest\Process Sample ﬂ Peo | Links >

1 - Mame ¢ I Sizel Tvpe IMDdiFied I

I-D L Process Sample.fls S5KE FLSFile 27.12,2005 11:03

i M report.xls 4KE Microsoft Excel Worksheet  27,12.2005 11:03
Process Sample ] unit 1.4s 16 KB Microsaft Excel Worksheet  27,12,2005 11:03

@Unit 2.xls 16 KB Microsoft Excel Worksheet  27,12,2005 11:03
Select an item to view its description, @Unit Juxls 16 KB Microsoft Excel Worksheet  27,12,2005 11:03
See also
My Documents
My Metwork Places
[y Camputer
|5 object(s) |55.4 KE |@I Iy Compuker ~

Fig. 10 HSC-Sim typical process files shown by Windowsy'Blomputer”.

The HSC-Sim based process model consists of sefdlesalwhich are always saved in the
same file folder. The structure of the HSC-Sim psxcmodel is also visible in the process
files, Fig. 10. The following steps are recommended

1. Create a separate folder for each process, ussathe name for the folder and process.
See previous Chapter 40.2.6.

2. The "File Save" dialog automatically saves all gaxfiles in this folder.

Description of the process files:

- FLSfiles: Contain graphical flowsheet and stredata, etc.
FLS files use Sim's own file format. HowevernSmay also import
and export other graphics file formats.

- XLS files: Contain Unit Models. The name must deactly the same as in the
graphical flowsheet, otherwise the XLS file willtriwe identified as the
unit file. These files may be password-protected.

XLS files use MS Excel 2000 file format.

- Report. XLS file Contain possible result, stredaance and remote control data.

The process folder may also contain many othes fddich may be linked to the graphical
flowsheet, such as pictures, Word or Excel files.

It is recommended to save the process regularlyguaidifferent folder name or to make
backups of this folder using Windows My ComputehisTmakes it possible to return to the

earlier versions of the process if something unetquehappens.
Note also that you may import the Unit Model fiteghe other process models.
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40.3 Graphical User Interface

This chapter gives some basic ideas of HSC-Simdi@et operation principles and keyboard
and mouse procedures. You may start the Flowshedtle by pressing Flowsheet in the HSC-
Sim main menu. The Flowsheet module works in qaiteimilar way to other object-based
drawing applications such as iGraph Flowchartetp@AD LT, etc.

Toolbars

[ Align

[ Combine
Crawing Tools
[] File Links

[ Infa

[ Qrder
Properties

[] Rotate/Flip
[] size
Standard

Bottom Right Corner Tools

Cancel | apply ok || [©SneptoGrid [© Persist Tool [Zoom: 100% | 63, 24

Fig. 11.View Toolbars menu. Toolbars selection shows desithe Toolbars in the same way
as in MS Excel or Word. You may move and resizébas with the mouse.

The following list specifies the main ideas of thgeration procedures:

1. View Toolbars (Fig. 11)
You may open View ToolBar dialog by selecting VieWgolBars from the menu. This
dialog makes it possible to show or hide toolb@te user may freely move and view/hide
Toolbars in the same way as in MS Excel or WordlBars are described in more detail in
the next Chapter 40.13.

2. Snap to Grid (Fig. 1, 2 Bottom right)
This setting helps to draw aligned diagrams. Nb& you may reverse the Snap to Grid
setting temporarily by holding dowht Gr .

3. Persist Tool(Fig. 1, 2 Bottom right)
This setting keeps the last selected tool. Téisigeful when you draw several similar
objects.

4. Mouse Tooltip Text
When you keep the mouse over the control yougeilla short description of the tool.

5. Drawing of Streams, Polylines, etc.
The first mouse click starts drawing, the sec(@td.) makes a corner and a double click or
Enter stops drawingBackspacemay be used to remove the last segmE&ist stops
drawing to the last segment.

6. Drawing of other Drawing Objects
Drawing starts when pressing the left mouse bufimwvn and stops when you release it. A
double click orSelect toolopens the Unit Model Editor.

7. Object Type (in Properties, Process Tab)
The Type property lets you set any drawing objedtnit or Stream.

8. NamelD (in Properties, Process Tab)
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10.

If you want to connect Flowsheet to the calcolatmodel then the NamelD of Unit and
Stream objects must be exactly the same as iratbelation model.

Mouse Right Button
When you hold the right button down you may mthesdiagram.

Mouse Wheel
The Wheel moves the drawing up/down. If you haldGr down then Zoom is activated.

Active Keys in Drawing Mode

Mouse left key  Down - Starts drawing. Up — Ends drawing objects.

Enter Ends drawing of stream and polyline objects.

Esc Removes the last drawing object and Ends drawlijects.
BackSpace Removes last segment of stream and polyline abject
Space Bar Starts and ends edit mode of streams and polylines
Alt Gr Down - Temporarily reverses Snap to Grid mode.

Active Keys in Object Edit Mode (Chapter 43.5.14)

Mouse left key May be used to select object.
BackSpace Removes points if mouse left key is down.

Mouse left double click Opens Object Calculation Model.

Automatic Setting Memory

The Flowsheet always remembers the last user aaergetting which you have used. These
settings will be saved in INI files, see chapter240
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40.3.1 Toolbars and Menus

The most important drawing and process tools mafpbed on the toolbars. Toolbars may
be opened and hidden with the View, Toolbars diaksge Fig. 11. The user may hide all
Toolbars except the Properties toolbar, becauge niearly always needed. Most Toolbar
options can also be found from the main menu, Eig.

J File Edit Wew Run Draw Tools Arrange Mode Daka  Help

Fig. 12. Flowsheet main menu options.

EEI FlowSheet Designer - C:4HSC6"Sim"Flowsheet',F

wsheet Designer - C:\HSCEYSi

Bt Designer - CHSCE'Sim" Flowsheet

Fig. 13.Flowsheet main menu File,

Edit and View options.

J File Edit ‘“iew PRun Draw Tools Arrange Mo | Edit  Yiew PRun Draw  Tools | Wew BRun Draw  Tools  Arrange |

T [ Mew, .. Chrl+1 &7 Undo Chrl+2 Toolbars. ..

| open... Chrb0 | | 0 Redn ol | | Status Bar

|_ [ save Process Ctr+s || 4 cut Chrl4 Options. .. Ale+0
:f Sawe Process As... Copy Selection Chrl+C Drawing &rea. .,

C Lock Excel Units with Password... Copy All Background...

E ﬁ Export Graphics. .. E Baste (ke Refresh Flowshest AR
& print... Cirep | | B Paste Special.. rid v
&

E Ao = Sellct ' Show Excel Calculatar, ..

- ] Duplicate
i Document Properties. .. p Zoom...
£
- 1} ...\Contrals TestiControls Test,fls Delete Shape(s) KES
2] ...rocess Samplel\Process Sample.fls Clear EIDWShEEt
d
o #% Eait f1[ ]

The main menu File selection contains the normal N&pen and Save selections as well as
Printing dialog with settings and print previewgFiL3. Note that "Save Process..." dialog
saves all the process files (FLS and XLS) intostuae folder.

The Edit selection contains the normal editingami Fig. 13. Note that most options work
also with multiselection. The Undo option is als@itble, which makes it possible to go
back several steps. However, it is recommendedye the flowsheet with different names,
allowing recovery of the drawing if MS Windows op#on fails.
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40.3.2 Properties / Process Toolbar
Froperties Froperties
Process | Drawing I niks | Process | Drawing I niks |
B General B General
Object Linit =l Object Stream
MameIl rit 1 MameIl Skream 2
Model Uit 1.xls SOurce Urit 1 j
Type Destinakion Jnit 2
Declaration Type
Ackive True Declaration
Sequence ] Active True
Object Source
Ohbject Twpe: UnitfStreamfDrawing Stream Source nit

{D Uniks in Current Flowsheet

Unit 2
Unit 3

-- Inpuk Skreams

{D Uniks in Current Flowsheet

Unit 2
Unit 3

-- Inpuk Skreams

Strearn 1 Strearn 1
Stream & Stream &
Skream 7 Skream 7
-- oubpuk Streams -- oubpuk Streams (Unik 1--= Unit 2
Skream 2
ool [Zoom: 100% |- 96, 24 4| ool [Zoom: 100% [z 110, 41 y

Fig. 14. Properties / Process Toolbar. Unit 1 is selectethe left toolbar and Stream 2 is
selected in the right toolbar. The stream comem flénit 1 unit and goes to Unit 2. The
process toolbar shows all the possible propertiesgiance.

The Properties toolbar is always visible in thewdbeet Design mode with three tabs. The
Processtabs specify the links to the model:

- Object: Stream / Unit / Drawing object

- NamelD: Unique name for stream or unit.

- Model: Name of the unit file. The name is always the s@$ NamelD.
- Type: Type of the unit or stream (reserved for futuse)u

- Source Specify source unit of stream.

- Destination: Specify destination unit of the stream.

- Declaration: Any additional information in text format (defasl empty).
- SequenceCalculation sequence of the units (not required).

- Active: Link to calculation module on/off

The process tab also shows all available unitsstr@ms in the Flowsheet or in the active
Process Model in the Calculation module. Thisristy be used to locate the unit and stream
names and the source and destination units fatthams.

The Simulation Mode uses NamelD to link the unitd atreams in the calculation module.
Therefore the NamelD property must be the samledri-towsheet and Process model.

IMPORTANT: Please press Enter after you change data in thbdiocell. This is not
always needed but it will ensure that the datdyréskaken into account.
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40.3.3 Properties / Drawing Toolbar

Froperties HE Froperties jsi
Process | Drawing | Units I Process | Drawing | niks |
@ Object Properties @ Object Properties
E Info E Info
| Ohject Rectanale | Ohject Palyling
= Line El Line
LineStyle 0 - Salid LineSkwle 0 - Solid
0.1 Linesiidth 0.1
LineColor - 0;0;0 LineColor - 0;0;0
= Fill E Arrows
Fill 5kl 0 - Salid Startstyvle 0- None
Backstyle 1 - Opaque Endstyle 7 - Filled Arrow
FillZalor |:| 255; 255; 255 Arrawiwidth 1.8
BackColor |:| 255; Z55; 255 ArrowLength 1.8
E Shadow ArrowFilled True
Shadowstyle 0 - Mone ArrowColor - 0;0;0
Cffsety 2 E Shadow
COffsety z Shadowstyle 0- MNone
ShadowZolor |:| 192; 192; 192 Offsety z
= Position Offsety z
Top 19,93 ShadowColor |:| 192; 192; 192
Left: 15.94 E Position
Height 13.95 Top 25,01
Width 21,92 Left 37.87
= Misc Height 15,94
| visible True width 29.89
El Misc
Wisible True
tick Stream Ends  [GEEE j
Linewidth Stick Stream Ends
Line Width (mm}) Stick Stream Ends to Unit objects
ool [Zoom: 100% [~ 108, 139 | ool [Zoom: 100% [+ 110, 41 S

Fig. 15. Drawing Toolbar with Unit (Rectangle) and Stredpolfline) object selected. The
properties may be listed in alphabetical or catiegdrorder.

The Drawing Toolbar shows all possible graphicalpgrties of the selected object. The list
of available properties depends on the object t¥is enables you to see all the possible
properties at a glance.

The Drawing properties have no effect on the pdésglbocess or distribution calculations,
i.e. they are only used to improve the illustratwel cosmetic effect of the flowsheet.

The Drawing toolbar may also be used to relocate rasize the objects using numerical
values in millimeters.

Multiselection of the same type of objects may beduto change the properties of all the
selected objects at the same time.

NOTE: The Flowsheet module has an extensive selectiainasfing properties and dialogs.
Most of them are very easy to use and they op@nadesimilar way to many other drawing
applications. Therefore these properties have @en lnescribed here.

IMPORTANT: Please press Enter after you change data in thébdiocell. This is not
always needed but it will ensure that the datdyrésktaken into account.
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40.3.4 Properties / Units Toolbar

Fig. 16. Properties Toolbar with Units tab selected. Therthnail pictures may be listed with
or without the unit names.

The Units Toolbar, Fig. 16, contains the availabié images which may be used in the process
flowsheet instead of simple rectangular unit olgedhe unit images make the flowsheet more
illustrative, in other respects they work in exptlie same manner as the normal units.

The user may select any unit image from the Undgsl@ar and draw the image in the drawing
area in the same way as the simple rectangle bjatts.Drag and Drop is another way to add
unit objects to the drawing area, and this willoafeaintain the original image height/width
ratio.

The available unit image collection depends on Whimit image folder is active. The Unit

Toolbar reads all image files from this active faldYou may change this folder by selecting
Browse. Press the round arrow button and selectv&¥o The unit images may exist, for
example, in the following folders:

C:\HSC6\Sim\Units\Ferro\
C:\HSC6\Sim\Units\Hydro-3D\
C:\HSC6\Sim\Units\Smelter-2D\
C:\HSC6\Sim\Units\Smelter-3D\
etc.

The next time you start the Flowsheet module it meitnember the last active Unit folder. You
may add your own unit images into this or any offieédter. If you would like a border around
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the unit image, please draw the border in the iomige. The following valid file formats must
be used:

Vector formats (Good resize features):
EMF — Windows Enhanced Metafile (Recommended)
WMF — Windows Metafile (old format)

Note that a large number of color gradients mayenhk image slow to access and move.

Bitmap formats (Fast, resize difficult, fixed size looks best)
JPG — JPEG format (small file, common). Note: Pesgive JPEG format does not work.
BMP — Windows bitmap (large file, common)

Color gradients have no effect on the speed indptformat.

Unit images may be drawn using the Flowsheet modulesing any drawing application which
saves files using the valid file formats. You mégoareplace the simple rectangle unit objects
with the unit images using the “Tools, Change P&tu” dialog.

Create New Unit Image

You may create new unit images using normal HSC-&iawing tools and save any
selected image as unit. To create a new unit inf@tpev these steps:

1. Draw a unit image in the size you would like tothe default size. Of course you may draw
in large size and reduce the size before the satage.

2. Select unit drawing objects with the Select tool.

3. Open the “Tool, Save Selection To Unit” dialog ajie the default name for the unit, then
save the unit image in the folder where you watd ive. The unit file name will be used as
the unit name in the Flowsheet. The EMF file formatkes it possible to resize the unit
image easily. Bitmap formats may sometimes berfastese.

4. If you save the unit file in the same folder whishalready open in the Unit toolbar, then
the list will be refreshed automatically.

Note that you may create unit images in any draveipglication which saves image files in
EMF, JPG or BMP format. Large size bitmap files, égample, 3000*2000 pixels may be used
but they will slow down the operating speed. Ususaithall 80*60 pixel unit images are OK.
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40.3.5 Drawing Toolbar (In Draw menu)

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
Fig. 17.Drawing Toolbar in horizontal mode.

Drawing tools may be selected from theawing Toolbar, Fig. 17 or from thédraw menu
selection, Fig. 12. The basic idea is that the fisstrselects the tool and then he/she can start t
draw the selected object with the mouse. The foligvtools are available, see Fig. 17:

1. Drawing Toolbar Drag Drop area.
2. Selecttool. This tool is used to select objects in thendng area.

3. Rotate tool enables you to rotate objects freely. Thesotiotation options may be found
from the Rotate/Flip Toolbar.

4. Unit tool creates rectangular units and labels. The&ties Units Toolbar, Fig. 16, may be
used to create units with an image.

5. Draw Fixed Polyline Streamtool creates polyline streams and labels. Thesarsis do not
stick with the unit objects. This may seem annoyimgome cases, but often makes the
editing of the flowsheet much more straightforwa¥du may open the edit mode using the
Edit Points icon or by pressing SpaceBar afterctelg a stream line.

6. Draw Direct Stream creates straight stream lines which stick on thee and destination units. The stick point mayp &xist within the unit
object (notin use, instead use Stick Stream Pnaigerty, Fig. 15).

7. Draw Polyline Stream creates polyline stream lines which stick on tharese and destination objects object (not in usgtead use Stick
Stream Ends property, Fig. 15)..

8. Draw Direct Midpoint Stream creates stream lines which start from the midpofrthe unit object but are visible only outside timit object
boundaries. These are not usually used in chemproakss flowsheets object (not in use, insteadstisk Stream Ends property, Fig. 15)..

9. Draw Polyline Midpoint Stream creates stream lines which start from the midpefrthe unit object but are visible only outside tmit object

boundaries. These are not usually used in chemproakss flowsheets object (not in use, insteadstisk Stream Ends property, Fig. 15)..

10.Draw Polygon creates closed polygons which have fill and shagooperties. Note that
you may easily add new points and edit the locatiaime existing points later on by double
clicking the polygon using Select.

11.Draw Polyline creates open polylines.

12.Draw Arc creates elliptical arcs.

13.Draw Bezier creates Bezier curves.

14.Draw Chord (Segment) creates Chord objects.

15. Draw Ellipse creates ellipse or circle objects.

16.Draw Line creates simple lines.

17.Draw Pie creates elliptical sector objects.

18. Draw Rectanglecreates rectangular objects.

19. Draw Rounded Rectanglecreates rounded rectangular objects.
20.Text creates text labels.

21.Insert Image inserts bitmap or vector format images from thetfh the flowsheet.

Active keys in_drawing mode With Polyline objectsthe Backspacekey removes the last
segment, thé&sc key removes the objecEnter ends drawing. See Chapter 40.4.1 for more
information.




HSC Chemistry ® 6.0 40 - 23(74)

Antti Roine, Jarkko-Mansikka-aho August 14, 2006 06120-ORC-T
Tuukka Kotiranta, Peter Bjorklund

Pertti Lamberg

40.3.6 Rotate / Flip Toolbar (in Arrange menu)

1

2 3 4 5 6

Fig. 18.Rotate / Flip Toolbar rotates the objects

ook wdpE

Rotate/Flip Toolbar Drag Drop area.
Rotate clockwise 90°

Rotate counter-clockwise 90°
Rotate to given angle

Flip Horizontal

Flip Vertical

40.3.7 Order Toolbar (in Arrange menu)

1

2 3 4 5

Fig. 19.0rder Toolbar brings the object layers to the frmmsends them back.

arwdE

Order Toolbar Drag Drop area.

Send to Backsends object layer to the back
Bring to Front sends object layer to the front.
Send backward one layer.

Bring forward one layer.

40.3.8 Combiner Toolbar (in Arrange menu)

1

2 3

Fig. 20.Combiner Toolbar combines objects.

1.
2.
3.

Combiner Toolbar Drag Drop area.
Group Objects tool combines the selected objects
UnGroup tool uncombines the selected objects

40.3.9 Size Toolbar (in Arrange menu)

1

2 3 4

Fig. 21.Size Toolbar may be used to make the height athvatithe selected object the same.

1.

2.
3.
4

Size ToolbarDrag Drop area.

Make same widthtool makes the selected object’s width the same.

Make same heighttool makes the selected object’s height the same.

Make same width and heightool makes the selected object’'s width and heigitsame.
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40.3.10 Alignment Toolbar (in Arrange menu)

1 2 3 4 5 6 7
Fig. 22.The Alignment Toolbar can be used to align seteotgects.

Alignment Toolbar Drag Drop area.

Align to Left will align the selected objects to the left bordéthe top object.
Align to Center will align the selected objects to the centerhef top object.
Align to Right will align the selected objects to the right barakthe top object.
Align to Top will align the selected objects to the top boralethe left object.
Align to Middle will align the selected objects to the middlelaf teft object.
Align to Bottom will align the selected objects to the bottomlwd teft object.

NooakwdpRE

40.3.11 Notes Toolbar

Fig. 23.The Notes Toolbar can be used to save text dataitostream or graphical objects.

40.3.12 File Links Toolbar

Fig. 24.The File links toolbar makes it possible to limkydypes of files to a unit, stream or any
other graphics objects on the flowsheet. For exanyuu may link a photo of the unit, unit data
history, etc. Using the Links toolbar you can castraglditional information onto the flowsheet.

40.3.13 Standard Toolbar (in File and Edit menu)

1 2 3 4 5 6 7 8 9 10 11 12 13 14
Fig. 25.Standard Toolbar in horizontal mode.
Standard toolbar contains the normal tools forddee, printing, etc.

Standard Toolbar Drag Drop area.

New Flowsheetwill delete the existing flowsheet and create & nee.
Openselection will start the File Open dialog and esgls the existing flowsheet.
Save Filewill run the File Save dialog for saving the fldvet.

Print dialog opens the print settings and print dialog.

Undo selection will undo the last action. Several uleels are available.

ook wbhpE
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7. Redowill cancel the last Undo operation.

8. Cut will copy and delete the selected objects.

9. Copy will copy the selected objects.

10. Pastewill run the paste routine.

11.Zoom will open the Zoom dialog. You may also zoom witle mouse wheel by holding
down the Alt Gr key.

12.Zoom Out will decrease the zoom setting by 10% units.

13.Zoom In will increase the zoom setting by 10% units.

14. Start Simulation will run the flowsheet in simulation mode, whichakes it possible to
connect the flowsheet with the process calculatioaule.

40.3.14 Tools Menu Selection

Fig. 26.Tools menu selection contains some important setLlitools.

Insert Header Label inserts a special Header label on the flowshekigiwshows the variable
selection in the Simulation mode, for example, 4tk Amount kg/h, etc.

Insert Link Label inserts a Link label which may be used to showe&adf any cell in the
calculation models in the spreadsheet.

Insert Name Labelcan be used to insert a name label in the Urfiite@am objects.

Insert Value Label can be used to insert a value label in the Unitoeam objects, which will
show the selected variable value in Simulation mode

Insert Text Label can be used to insert a text label in the Unibtoeam objects.

Change Pictureinserts an image in the selected unit or areacbbje

Save Selection To Unitan be used to create a new Unit image file. Eiraiv any kind of unit
image and then select all the graphical object€lvbelong to the unit. Then save the selected
objects as a unit image using “Save Selection T’ Uhhe unit images may be saved in EMF
(recommended), JPG and BMP file format. Please! oty EMF may be resized without loss
in image resolution.

Global Variable Editor Not currently in use, because the Sync modes hepkaced this
dialog. However in future Sim versions this dialogy be reactivated.

Repair FlowsheetUpdates the old Sim 5.x flowsheet to the curremt &0 format.
Persist Toolkeeps the last selected tool after the drawingokas finished.
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40.4 Drawing Flowsheets

Fig. 27 Flowsheet module main drawing tools on the lefiihar and image unit thumbnail
browser on the right.

You can draw the flowsheet first and then speduigy variable list or vice versa. The most
important drawing tools and options are shown g B8. Usually the Snap to Grid should
be always on, which makes it easy to align theatbjdrawn. You may sometimes need to
set Snap to Grid off in order to fine-tune the tomas of the text Labels. You may get the
same effect by holding down tiAdt Gr key and moving the objects with mouse. The Persist
Tool keeps the last used drawing tool in the memory

Fig. 28 The most important drawing tools and drawing apti see Fig. 14 for locations of
these tools. The drawing tools are: Unit, Streaele@& and Edit Stream Points.

First, select th&nit tool and draw some units by clicking the drawing carwidk a mouse
and keep the mouse’s left button down while drawigte that you may also select image
units from the Units thumbnail browser, see Fig. Tieese image units may look better but
sometimes they make the flowsheet fussy. The hasis and image units behave exactly in
the same manner in the flowsheet, and you may @@tensert new images into the basic
units, using Tools, Change Picture.. dialog.



HSC Chemistry ® 6.0 40 - 28(74)

Antti Roine, Jarkko-Mansikka-aho August 14, 2006 06120-ORC-T
Tuukka Kotiranta, Peter Bjorklund

Pertti Lamberg

The next step is to draw thetreams which connect the units. First, select the Stream
drawing tool, Fig. 28, click the start point of teigeam and do NOT keep the mouse button
down when drawing. Draw the stream simply by clhickon the corner points of the stream;
and to stop the drawing, press Enter or doublé dhie end point.

NOTE: Please do not resize the streams using gelelsandle (sizing handle) as this will
also resize the arrow heads. If you want to moeeldhation of the polyline stream points
then:

1.

2.
3.

Select the stream and press the Edit Stream Hoonis see Fig. 29, or press the Space
Bar.

The stream points turn yellow and then you may eribxese points using the mouse.
You may add new points by clicking and moving loa stream line.

You may remove points by selecting the point aedping the mouse’s left button
down while pressing Back Space on the keyboard.

When you are ready, please press Edit Pointsaooa again or press the Space Bar.

Fig. 29 The Stream 6 has been selected for editing. Yay move the yellow points with
the mouse and add new points by clicking the lime: @elete selected point with BackSpace.
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Fig. 30 Unit and Stream drawing object main properties.

The most important properties of the units andastremay be found from the Process tab of
the Properties Toolbar, see Fig. 30. The esseniplerties have been underlined:

Object: The object property specifies the graphical abjgoe. The Sim calculation routine
uses this property to specify the units and stredfoas may change this property, but please
be careful.

NamelD: NamelD specifies the name of the unit or stregons may change these names,
but duplicate names are not valid.

Model: The model property specifies the file name of tiné model, which must be the
same as the unit name. The Unit files are locatetthe same folder as the FLS flowsheet
file.

Source The ource property specifies the source unit stfeam object. A question mark "?"
means that the source is a raw material.

Destination: The destination property specifies the destinatioit of a stream object. A
question mark "?" means that the destination idyzt stream.

Please note that Sim calculation routines use #oand Destination properties to identify
the source and destination of the streams. In offteds, if there is disagreement with a
source between the source property and graphioasfieet then the Sim calculation
routines use the Source property. This means tatdp not need to draw very long and
complicated streams on the graphical flowsheeteatsit is sufficient that you specify the
Source and Destination properties.

Type: Type of the unit or stream. Reserved for futura ersions.
Declaration: You may give some additional information in theld, usually it is empty.
Active: You may use this property to temporarily deadgvie unit or stream.

SequenceNormally the units are recalculated downstreaawdwver, with this property you

may force to recalculate units in a given orderlu€a'l" in this property forces to

recalculate this unit first. In some cases thispprty may be used to improve the
convergence and speed of the iterations.
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Fig. 31 Flowsheet main menu Tools selection. The Insexadér Label and Insert Value
Label may be the most important tools in this sinm

When you have got the drawing ready you may adcesaditional labels, see Fig. 31.

For example théleader labelmay be very useful when you visualize the caleotatesults

in the Run mode. You may add the Header label sélection "Insert Header Label". The
top left and top right corner is often a good lamatfor the header label, which shows the
selected Variable name in the Run mode, see Fig. 31

The Link Label can be used to show any cell value from the calmd models in the
flowsheet. By using the "Link CellRef" property Ik label, you may pick up the active
cell reference into this property or you may typmanually.

TheValue Labelscan be used to show the actual value of selectéalbles in the stream in
the Run mode. First, select the stream then s#tectnsert Value Label from the Tools,
menu, see Fig. 31. You can easily relocate theldaleng the mouse. Usually the Value
Label [value] is added to all the streams, see Fig.
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40.4.1 Editing of Drawing Objects

With the Select tool you may select objects fotiedi The Properties Toolbar may be used to
change the properties and location of an objectwéver, the shape of the object can be
changed in the object edit mode only. You may dfaetedit mode by pressiriedit Points
icon, Fig. 28, or pressing thgpace Barwhen object is selected. The edit procedure depend
the object type. The following pictures give a bimgroduction to the editing possibilities.

Fig. 32. Editing of Fixed Polyline Stream, polyline, polygand Bezier objects:
- Move yellow points with mouse (mouse pointer msstcross arrow).
- Add new points by clicking on the line
- Remove points with Backspace key (hold left mdustgon down).
- You may change the source and destination urita the Process Toolbar.

Fig. 33. Editing of Polyline Stream and Polyline Midpoirtté&m objects:
- Yellow points may be used to move the locatiothefwhole line.
Green points may be used to move the start otomadion.
The stream line always keeps the original soarakedestination units. You cannot
change these in the Process Toolbar!
Draw a new stream if you want to change the sooralestination units.

NOTE 1: If you are drawing a new polyline object then:
Backspaceremoves the last segment.
Escremoves the last segment and ends the drawing.
Enter ends the drawing.

NOTE 2: TheOpenDraw setting, Fig. 5, has a great effect orafipearance of the flowsheet
in the edit mode. However, it has no effect ongiecedure.
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40.4.2 Editing Unit Images

Fig. 34. Ungroup unit object and save it back to unit.

The user may edit unit images. However, these imagest first be ungrouped into basic
graphical objects. These basic graphical objectg meaedited in the normal way. The final step
is to save selected objects into one unit image.sképs may be summarized as follows:

1) Select the unit.

2) Select "Arrange, Combine, Ungroup...".

3) Change, for example, the line or fill colorstloé drawing objects.

4) Select all drawing objects again.

5) Select "Tools, Save selection to Unit...", saseEMF format.

This procedure may be used to create new unit imagéifferent file formats.
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40.5

Creating a Variable List

Fig. 35 Sim Input-sheet with a simple variable list. Yzan type the list directly in column
B and by clicking the TYPE label, you can speciifg variable type and measure unit.

The custom-made variable list makes it possiblaetize the HSC-Sim module in many
different types of simulation applications, such asineralogical, chemical,

hydrometallurgical, pyrometallurgical, economioplbgical, etc. Only your imagination sets
the limits! The custom-made variable list giveotdf flexibility but the drawback is that
the user must know what he/she is doing.

This is also the main reason why the specificatbithe variable list is one of the most
important tasks in the new model development stéga.may easily add/delete/edit/sort the
variable list later on, but still it may be besttty to specify a complete variable list right at
the beginning or at least before you start to erta calculation models.

The most important selection you must make wheattrg the variable list is the format of
species (= format of material). There are two opio

1. Elements (Fe, Ag, O, etc.): This makes it posdiblealculate the element balances of the
units and is often the best selection when usirigg gimple models.

2. Species (Na2S, CaCO3, CO2(qg), H(+a), CO3(-2a)): &this selection makes it possible,
for example, to calculate enthalpies of the inpwt autput streams and the energy balances.
This format is recommended for the more complicatedels.

Another very important task is to divide the spedreo meaningful phases because only this
makes it possible to calculate phase propertiesdénsities and compositions, Fig. 39.

IMPORTANT NOTE : The Sync option must be ON, see Fig. 35. It symailzes the Input,
Output and Dist sheet columns A - D with each other
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Fig. 36 Sim Input-sheet with a simple variable list. Ymay create column D formulas
automatically by using the "Create Formulas Alltbaoton Type dialog, Fig. 3.

The first step is to type the variable list straigito the Input or Output sheet column B, Fig.
35. The font color turns from black to red if thermble is not found from the HSC main
database. However, this does not cause any probienyg@u do not use the Sim

thermochemical Addin functions. For example, thedvisold" in Fig. 36 cannot be found

from the HSC database, however, it may be usedrasable name.

The next step is to specify the variable types, B The model sheet wizards use the
variable type specification in column A for formwad cell reference generation. If you do
not use wizards, then you do not need to spec#éytyphes. However, it is recommended to
carry out the type specification in any case beedumakes the variable list easier to read.

The meaning of the Input, Output and Dist sheairmols may be summarized as follows:

Column A - Type: Specifies the Row Type. Basically the Type colunoesinot have any
effect on the calculations, however, the Wizards Tgpe information when they create the
calculation formulas. The Type parameter may beipd using Type Dialog, Fig. 3. The
possible selections are:

- A Amount
- T Temperature
- Pr Pressure
- P Phase
- Species. Red font = cannot be found from HSGluize.
Note: You may press "Mouse right button to broW&C database.
H Enthalpy
F Mass Fraction (Base species must be specified)
D Density (Aqueous phase species mass fractions meuspecified)
- C Concentration
L
M
o

Private
Mineral
Other
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- V  Volume

The number section in the row type parameter mdanphase number. For example: A2 =
Amount of phase 2, H3 = enthalpy of phase 3, etc.

NOTE: It is recommended to introduce the varialllegays in the above order; this makes
the reuse of the unit models in different processeash easier, because the variables must be
in the same order within one process!

The species are recommended to divide into meauirgirases such as "Gas Phase",
"Water Phase", "Pure Substances", etc. The phasesdsbe introduced as a continuous list!
Wizards are not able to generate, for example, dpyhor Amount formulas without the
specification of phase and species variables,3ag.

Column B - Variable: Specifies the Variable Name. The Wizards use aab&iname to
identify the variables but the simulation calcudas do not utilize this name. The calculation
routines transport stream variable data betweets asi columns anassume that the order
of variables is the same in all the units

Column C - Unit: Specifies the measurement unit. Please use the s@amgurement units
within all the process unit models. In the futur8&Sim versions, more flexibility will be
added to the measure unit column.

Column D - Formula: Specifies the Excel type cell formula which willtamatically be
added into the Excel model Input - and Output-shaetColumn D. This same formula will
also be used by the output stream columns on theuDsheet.

Columns E-> - Streams:Each stream has one own column.
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Fig. 37 HSC-Sim Global and AddIn function default units.

The default measurement units are shown at therbatght of the Model Editor form, Fig.
36. You may change these by clicking the unit lsb@&he Global Measure Unit dialog
makes it possible to change these units, Fig.t33.recommeded to select the measure units
when you start to create a new process, the wizatdghese units into column C, Fig. 36.

Do not use HSC AddIn function =Units("C";"MJ") @our model sheet, because this Addin
function may overwrite the global setting and cags®lom results. See examples, of AddIn-
functions syntax from: C:\HSC6\AddIns\AddInSampleX

Note that the Global Measure Units do not autorafificchange the measure units which
have been used within the Input, Output, Dist, @irgnd Model sheets. For example, if the
AddIn function returns the enthalpy as Mcal you reagily convert these values to MWh in
your Model sheet by multiplying by 1.162.

In the next HSC-Sim versions, the Wizards will bedd to accept a wider range of different
measure units.

A variable list sample is shown in Fig. 38. It Haeen created with the Sample Variable
Listkey, see Fig. 3. Note that the species have beaded into phases. The phase list must
be continuous i.e. do not use empty rows withinligte
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Fig. 38 A variable list sample with variable type spemtions in column A. The formulas
in column D have been automatically created. The raaterials have not yet been
introduced. Most types have been attached with as@mumber, for example, H2 is the
enthalpy of phase number 2.



HSC Chemistry ® 6.0 40 - 38(74)

Antti Roine, Jarkko-Mansikka-aho August 14, 2006 06120-ORC-T
Tuukka Kotiranta, Peter Bjorklund
Pertti Lamberg



HSC Chemistry ® 6.0 40 - 39(74)

Antti Roine, Jarkko-Mansikka-aho August 14, 2006 06120-ORC-T
Tuukka Kotiranta, Peter Bjorklund
Pertti Lamberg

40.6

Creating Calculation Models

Fig. 40 Output stream distribution Wizard may be staiffredn the Model Editor Wizard
menu.

The calculation model creates a mathematical carmme¢émodel) between the Input and
Output streams of one Unit. Usually this model roaydivided into two parts:

1. Main Model - chemical, mineralogical, equilibrium, flotatidfiiter, etc.

All the input material streams are combined amahitime calculation model transforms the
raw materials into products by using some matheakformulas based on chemistry,
physics or economy. The Sim-Wizard creates a maideionto the Model sheet. The
main model may also be called theansformation model.

2. Distribution Model - based on distribution percentages

The Distribution model divides the products of thain model into the Output streams. If
there is only one output stream then 100% of tluelgets enter this stream. The Sim
Wizard creates a Distribution model on the Distd &utput- sheets.

The basic idea is that the unit models (Unit 1,t@niUnit 3, etc.) are independent and do not
have any information about each other. The grapfimasheet contains the information of
the stream connections between the units. The latitmu routine transmits the information
(data) between the calculation units according e graphical flowsheet Source and
Destination properties. This unit "autonomy" coricekes it easier to reuse units in other
processes.

However, sometimes some special information needsettransmitted between the units,
and in these cases external links may be usedeXteenal link syntax is quite simple: The
formula: "=[Unit 2]Dist!G7" links cell into cell @ of Dist-sheet in Unit 2. When you reuse
this kind of unit model in some other process yatstmemember to check the external links.
Note that External Links may also generate troutes "Circular References" unlike the
normal data transferred using stream variables.
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40.6.1 Creating a Distribution Model

Even the simplest main model which only combines ltiput materials feeds without any
transformations needs a distribution model. Distidn percentages may be typed manually
into the Dist sheet. However, the Distribution Mbuézard offers an easier way, Fig. 40.
The first step is to open Distribution Wizard frahe Wizard menu, the second step is to
type the distribution percentages into the vargbleg. 40. The last step is to pr&gve
ChangesandClosethe Wizard. This procedure must be repeated fcn aait.

The Apply Distributions procedure creates the Mdimdel on the Model sheet, Fig. 41, fills
the Dist sheet, Fig. 42 and updates formulas orOumgput sheet,. Fig. 43. These formulas
divide the Main model products into Output streams.

Fig. 41 Distribution Wizard creates the Main Model. liistbase the total sum of each input
variable ends up in the output streams withoutwemable transformations.

The Chemical Reactions Wizard may be used to cremt® sophisticated Main models
based on the chemical reactions. You may also ergatir own models manually using
Excel formulas, cell references and Sim Addin fiomg on the Model sheet or on your own
sheets. However, your own sheets must be locatedtbé Model sheet!

The chance to create a customized variable listyaod own main models using familiar
Excel type syntax makes HSC-Sim very flexible f@anmy types of simulation applications.

One unit model is always one file in Excel 200@ fibrmat. This makes it possible to reuse
models in other processes. However, the orderefvéniable list must be the same. In this
sense it is a good idea to use the same variablenlall your processes in spite of the fact
that some of the variables are not needed (ameud}sn all applications.

Please note that you can also create your own madaler MS Excel, since HSC-Sim
AddIn functions also operate under Excel. Howeyease use the "C:\HSC6\Template
Model. XLS" file or some original Sim model file astemplate for your own models. Do not
delete or overwrite the "Template Model. XLS" filedause Sim uses this file as a template.
In MS Excel you may create your own VBA macros ddferent calculation models. HSC-
Sim usually retains VBA macros in XLS files, butldes not run these macros.
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Fig. 42 Distribution Wizard fills Dist sheet with givenstribution percentages.

Fig. 43 Distribution Wizard updates formulas on the Outghweet.
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40.6.2 Creating Reaction Equation Models

Fig. 44 Distribution Wizard updates formulas on the Outghweet.

The main calculation model transforms the inpuialde values into output variable values
using some mathematical formulas. The main mode} b created manually as in MS
Excel on the Model sheet or by using HSC-Sim Wiga@uite often the main model is
based on the chemical reactions. In this case yay apen the Chemical Reactions Wizard
using selection "Wizard, Chemical Reactions Modelrom the Model Editor menu, Fig. 2.

The first step is to type the reactions that mayplea in the process unit in the Chemical
Reaction Wizard, Fig. 44. You may use the BrowselDBon to check the correct syntax
for the species from the HSC active databases.

The first species of each reaction is assumed thd&aw material" which is consumed in

this reaction. You must keep in mind that you carsamsume more than 100% of the raw
materials. For example, FeS is the raw materiahmreactions 1 and 2, Fig. 44. The sum of
Progress % cannot be more than 100% (80% + 20%puagh it can be less than 100%. The
next species in the reaction equations will autasally be taken into account when model is
created on the basis of the reaction stoichiométogvever, it is still recommended to check
for the negative amounts in the Model-sheet andrenthese, for example, by decreasing
Progress %.

The second step is to test the balances by prefsnBalance button. This gives an OK in

the Balance column, showing that everything is UKe balance test will also give enthalpy

H and equilibrium constant K for the reaction at°Z5if all the species are found in the

active HSC databases. Negative H values mean #adtidreleased in the reaction, whereas
positive values mean that more heat is needed.eLKrgalues (>1) mean that the reaction

tends to go to the right and small values (<1) nteahthe reaction tends to go to the left in

the equilibrium state.

Please remember to fill in the Distribution shem, tFig. 44, because you must divide the
products into the output streams.

When you are happy with the reactions and distiolbstpressSSave Changesnd close the
dialog. This will create both the main model anstritbution model on the Output, Dist and
Model sheets.
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Fig. 45 Balance range of the main model made by the iDigion Wizard.

The Distribution Wizard automatically creates thald®ice range and Chemical Reaction
range in the Model sheet. The Balance range cantaput, Output and Balance formulas
which summarize the total input and output amowhtthe variables. Usually the balances
are not zero if variable transformations (reactjatur in the unit, Fig. 45.

Note that if the species namered this means that species is not found in the a¢liSE€
databases. This will not cause any problems wehelement balance calculations, but if you
would also like to calculate energy balances tienshare of this unknown species will be

missing from the energy balance.

An automatically filled range is outlined with audite line border. Please do not change the
formulas within this range if you are not absolyt®lire of what you are doing.



Antti Roine, Ja

HSC Chemistry ® 6.0 40 - 44(74)

rkko-Mansikka-aho August 14, 2006 06120-ORC-T

Tuukka Kotiranta, Peter Bjorklund

Pertti Lamberg

Fig. 46 Reactions range of the main model made by theibugion Wizard.

The Reactions range contains the list of the reastiwith progress percentages and
necessary cell formulas to calculate the reactedpaoduced amounts of the species. You
may change the Progress% cells manually, for exanipl and H11. Please do not change
the other cells within this area that have beehrad with the double line border.

Note that the species namerésl if this species is not found in the variable liEhis may
lead to errors. In this case the red color of "Bal#, Fig. 46, means that Fe(+3a) will be not
copied to the output sheet and this will cause nadtealance error. Please add Fe(+3a) into
the variable list and rerun the Wizard. In caselettrons the red color does not matter as
long as we are not interested in electron balances.
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40.6.3 Creating Equilibrium Models

Fig. 47. HSC StreamEQ AddIn function calculates the efiim amounts (mol) of the
stream at given temperature 1500 °C and pressbae. 1

Some process units operate near the equilibriurdigtons at least in part. In these cases the
StreamEQ HSC Addin function may be used to caleuthe total or partial equilibrium
composition of the stream. Equilibrium models atsoauseful when developing new
processes without any experimental process dagsth®eexample in:
C:\HSC6\AddIns\AddInSample.XLS.

The StreamEQ function is quite different than thlkeeo HSC Addin functions because it
returns an array. All the other functions returmatdue. Therefore, the MS Excel type array
formulas must be used, see Fig. 47. Note that $keofiarray functions is not as flexible as
the use of normal Excel type functions. For examgile array function arguments must be
located in a continuous block. Note also that wipen end the array function editing you
must keegCTRL + SHIF keys down when you press Enter

The species must be divided into phases for theaBtEQ function. The phase flggmust
be used at the beginning of the phase name, Fig. 47

We recommend using equilibrium models on your owwrdil sheets to transform the input
species to output species. In some cases you niee \BtreamEQ function only for one
phase which is considered to reach the equilibreunh as the gas phase.

However, in many cases the real processes do eoatgpat equilibrium state due to kinetic
barriers and temperature and composition gradiéntshese cases it is better to base the
main process model on the experimental observatiodsdata. The HSC-Sim "Tools, Data
Fit...” sub-module may be used to convert the expemtal process data into formulas
which may be used in Unit models.
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40.7  Specifying Raw Materials

Fig. 48 Specification of raw material amounts.

You must give some amounts for the raw materiafserbeyou test your models. You may
double click the raw material stream in the flonsh&ig. 27. In this process, Stream 1 is the
only real raw material stream and the other inprgasns are internal ones. In this case you
must specify only Stream 1 amounts, Fig. 48. Yow raéso give some amounts for
circulating Stream 6 and 7, although these amowiitde overwritten by the calculation
routine which transports the data from source tanihe destination unit.

It is recommended to use the same measure unigdl fitve species (t/h) in the first HSC-Sim
versions, although in later versions a full rangerats will be supported. Note that you may
change easily the number format of the variable usmg Variable Type Editor, Fig. 3, or
using "Format, Cells..." menu selection.
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40.8

Running Simulation

Fig. 49 View of Run Mode. You may start calculations lvggsing the Calculate icon.

When you have created the process model in Desigrae then you may start the
simulation mode by pressing thetart Simulation icon or by selecting "Run, Start
Simulation..." from the main menu, Fig. 1. Howevdegse save your process first using the
"File, Save Process" or "File, Save Process As. tibop because this allows recovery after
any MS Windows or HSC-Sim errors.

The starting of Run mode may take a little timeg. 9, because internal calculation plan
table will be created to optimize the calculatigreesd. So you may change the content of
cells in the Run mode, but do not move cells, rowsolumns in Excel Model, because this
does not update the internal calculation plan.

In the Run mode the flowsheet is locked. Howevey gnay open Excel Editor in the same
way as in the Designer mode and change the rawrialaggmounts or some other

parameters. However, please do not add variallesige formulas, or modify models in the
Run Mode. You may use also Variables ToolBar tangeavalues, see Fig. 50.

The first step in the Run mode is usually to ptessCalculate icon, which will carry out the
calculations and move material downstream. Thisgutore will be executed 5 times, or any
other number of iterations that you specify in Bmunds text box. If you have no internal
circulation streams then some 1 - 2 rounds are gmdwt if you have a lot of internal
circulations then more iterations are needed. Yay reelect a critical stream on the
Variables ToolBar before pressing Calculate andenles the stabilization of the
composition. When the changes stop then equilibhasibeen reached.
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Fig. 50 Run Mode: the Visualize option has been selebbedSold. Stream 3 has been
selected for the Variables ToolBar.

When you have carried out the calculations the sloset is automatically updated with the
selected Variable data. You may change this seleaising the Variable Selection drop-
down list box, Fig. 50. You may use the Visualizdestion to change default visualize
settings. Visualized flowsheets offer an illustvativay to report the simulation results. The
Visualize options make it possible to adjust lindths or the range, etc. These diagrams are
sometimes calledSankey diagrams. . Note that the HSC-Sim module draws Sankey
diagrams automatically.

You may easily Copy-Paste the visualized flowshett other Windows applications by
pressing the Copy icon. Then Paste the flowsheéetWord or Excel using the "Edit, Paste
Special..., Picture, OK" procedure.

You may also print and export the flowsheet adeaufsing the Tools menu options, see Fig.
26. Several graphics formats are supported.

Another useful option is "Show Calculation MonitorThis will show details of the
calculation in table format, Fig. 51. It may be dis® identify possible convergence
problems with Controls and circular internal streaffig. 52.

Monitoring lterations and Controls

You may monitor calculations progress and conteslations by "Tools, Show Calculation
Monitor" selection, see Fig. 51, 52 and 53.
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Fig. 51 Run Mode: Tools menu options.

Fig. 52 Run Mode: Show Calculation Monitor Dialog may lbieed to follow the
calculations.
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Fig. 53 Show Calculation Monitor Dialog may be used towltheControl Monitor .

The Control monitor, Fig. 53, shows the iteratiameergence of the active selected control.
Note that:

- Excel Editor of one unit must be open
- Control sheet must be open
- One control must be selected.

You may then test the iteration of the active gel@control by pressing tieun Controls
button. This gives the extrapolates values in nurabd in graphical format.
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40.8.1 Visualize Settings Dialog

Fig. 54.Visualize dialog. Gold is an active variable irstbase.

The stream variable amounts may be visualized ugiagHSC-Sim Run mode Visualize
option. The Visualize Settings dialog may be ugechiange the Visualize options.

The Visualize dialoqg settings, Fig. 54 are:

Set Line Width Varies stream line width

Set Color Varies stream color with positive andaie@ values
Maximum Line Width  Maximum line width with maximuamount
Positive Color Stream line color if value is posti
Negative Color Stream line color if value is negati

Use Absolute Values Automatic line width

MIN User selected minimum value

MAX User selected maximum value

Close Closes the dialog

Reset Flowsheet Recovers default line widths

Visualize flowsheet Shows the effect on the flovethe

Note that flowsheets do not calculate anythingy thiely show the stream line widths using
the given variable values.
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40.9

Printing

Fig. 55.
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Flowsheet module Print dialog with Print Preview.

The same printing dialog is available in the FlogethDesign and Simulation mode, Fig. 55.
The Print Preview on the right side shows the éftécselected printing properties on the
print results. The narrow gray area on the edgéiseopaper shows the area where the printer
cannot print. The property list on the left shotws &vailable settings such as:

Printer:

Driver:

Color Mode
Paper Size
Orientation

Fit to Page

Top

Left

Zoom

Print Area

Print Hidden Objects
Print Background

Print Setup changes
Print Setup changes
B&W / Color
Print Setup changes
Portrait / Landscape
True / False
Top margin. Black horizontal line in Preview.
Left margin. Black vertical line in Preview.
Zoom setting used in printing.
Picture / Objects only
Also prints object of whicle thisible property is False.
Also prints background picturele flowsheet



Antti Roine, Ja

HSC Chemistry ® 6.0 40 - 55(74)

rkko-Mansikka-aho August 14, 2006 06120-ORC-T

Tuukka Kotiranta, Peter Bjorklund

Pertti Lamberg

40.10 Element Balances of the Units

Fig. 56. Element balances of process units.

The unit calculation models made manually or using Wizards may contain errors. One
typical error is that the element balance betwhenriput and output streams is not zero.

You may easily check the element balances of thes uny selecting "Tools, Element
Balances..." in the Model Editor menu, Fig. 2. Thifl start the procedure to calculate the
element balances of all the units and give thestherBalances sheet of the Report form,
Fig. 56. This procedure will hide those elementiomis which do not contain material.

This procedure calculates element balances bas#tanput and output stream elements. It
also takes into account the possible species (RaS04, etc.) in the variable list. However,
it cannot take into account the elements whichhaadeng behind the variable names such as
"Gold". If you want the Element Balance procedweheck the element balances, please
use chemical formulas (Mg, Ca, SiO2, SO2(g), SGY(-2tc.) as species names in the
variable list.

You may save, print and Copy-Paste the elemenhbaleesults collected on the Sim Report
form using normal menu selections, Fig. 56. Wham yave an FLS file the Report. XLS file
will be automatically saved in the same folder.
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40.11 List of Streams - Variable Balances

Fig. 57: List of input, output and internal Streams witiriable balances.

Quite often the results of the simulation calcwasi are presented as a stream list with
calculated variable values.

You may easily generate a stream list with values\ariable balances by selecting "Tools,
List Streams..." in the Model Editor menu, Fig. 2.isThill collect the streams on the

Streams sheet of the Sim Report form. This proeedull also sort streams into three
categories: Input, Output and Internal streams, %4g In this list all the variable names will

be shown in row 2.

Please note that this is not an element balanstead it is a variable balance and the
variable balance does not need to be zero for theeps. For example, if the Al203 is
converted into metallic aluminum Al then the Al268lance of the process cannot be zero!

When you save the FLS file the Report.XLS file vidkk automatically saved in the same
folder.
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40.12 Creating Controls

Fig. 58 The calculation model “Controls sheet” with ommatrol.

Row Name Description

3 Number Control Number (max = 254)
4 Y Target Name Name of Y (optional)

5 Process Unit Unit name (optional)

6 Sl Units Measure unit name (optional)
7 Set Point Set point of Y (obligatory)

8 Measured Y cell reference (obligatory)

9 Tolerance +/- Y tolerance (obligatory

10 Method Iteration method (obligatory)

Auto (default, run process until Y oscillationdsih
Auto Slow (run process "Rounds Forced" times)
11 X Variable Name Name of X (optional)

12 Process Unit Unit name (optional)

13 Sl Unit Measure unit name (optional)

14  Value X cell reference (obligatory)

15 X Min Limit Min limit of X range (obligatory)

16 X Max Limit Max limit of X range (obligatory)

17 X Max Step Maximum X Step (optional, default = @ot in use)

18 Iterations Max iteration number (obligatory)
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19 Rounds Forced Run process given times (optidefult = 0 = not in use)
20  Active Set control ON/OFF (optional, default NO

The HSC-Sim Controls sheet makes it possible tatereontrols which regulate some target
parameter cell value using some other variablewedile, Fig. 58. In principle, Sim Control
works exactly like real process control, for exaenmh a real process unit you may give a set
point to process unit temperature and regulatéstmperature using the fuel oil feed.

You may create two types of controls:

1. Internal control where the target and variable cells exist in #Hraesunit (FAST).
2. External control where the target and variable cells exist in d#fé units (SLOW).

Calculation of the internal control is fasécause only one unit is calculated. Calculatibn o
external control may take more tirhecause material must be recirculated within thele
process several times to reach a stable target.vélbu may speed up iterations of external
controls with narrow X min and X max limits and seaable tolerance value. It is
recommended to moderate large changes of the amath use of X Max Step. This will
usually prevent the external control to run thecpss out of order.

To create one control on the Controls sheet, yoe ha set at least the Target cell reference
and Variable cell reference and also the limits fbe variable. You may type this
information onto the Controls sheet manually or yoay use the Controls menu options.
Please use the following procedure:

1. Click the first available controls column (C ->) the Controls sheet.

2. Locate the Target cell from your active unit aptest "Controls, Set Unit Target".

3. Type the name and measure unit into rows 4 augiopal).

4. Locate the Variable cell from your active unit a&dect "Controls, Set Unit Variable".

5. Type the name and measure unit in rows 12 andgdi®(al).

6. TypeLimit Min andMax in rows 15 and 16, a narrow limit speeds up catounhs.

7. Give the maximum number for the iterations in ro8v

If you want to use an external target cell from sasther process unit then use "Set Process

Target" and "Set Process Variable" selections. Willsopen the unit selection dialog, which
may be used to guide the external cell referentleg@orrect unit.

The defaultTolerance is +/-. The small tolerance increases calculatiome and large
tolerance increases errors. Some 2% of the ta@eevmay be a good compromise. The
control will not be calculated if the value is wittthe tolerance.

The Controls sheet uses Auttethod to iterate target value by changing a variable eal
the Method is not specified. Other valid methods ar

1. Auto: Default method, combination of Tangent and Leasia®g method. This method
will change variable X value and it will stop itémn when target Y value oscillation
ends. Usually, "Auto" is the best selection.

2. Auto Slow Similar to previous, but with the external cogréorce to run process as
many times as given in "Rounds Forced" cell. Thib make possible to control the
"slow processes".
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Sim Controls have exactly the sahmaitations as real process controls, for example:

If the target cell does not depend on the vagiakll value then the iterations will fail.

If an external variable cell is used then theegy e a long delay before the effect on the
target value is visible. In these cases a lotevhiion rounds may be needed to reach the
set point. This may increase the calculation time.

The first HSC-Sim version used the old HSC Chermisbftware iteration routine, which
assumes an immediate response between the vasfadiige and the new target value. In the
basic HSC this is always a valid assumption. Howaunehe HSC-Sim module the response
of the target value to the variable change may lirevalelays, especially if the target and
variable cell references are located in differercpss units. In future HSC-Sim versions
more effort will be put into developing Controlsriation routines.

PLEASE NOTE:

Usually you may create a large numberimdernal controls in a process without a
dramatic drop down of calculations speed becausgetido not increase the number of
calculation rounds of the process.

Usually only a fewexternal controls can be used in one process without considerable
decrease in the calculation speed because exwmwntbls may multiply the calculation
rounds of the process.

It is recommended to moderate large changese#hiable with use ok _Max Step,
when using external controls with slow respons.

If you want to keep some concentration lower thaset point (8 g/l) by changing bleed
stream amount (valve 0 - 100%). Please use annexteontrol if the bleed and
concentration cells exist in different units.

The RecoveryX add-in function cannot be used in the Target de#icause it is
recalculated only after all calculation Rounds hbgen finished.

The large number of thermochemical add-in fumdi@treamH, StreamS, etc.) may
drop down calculation speed if the argument vahenges in each control iteration round
because the data search from the H, S and Cp datdhkes time. Use these add-in
functions only when needed.
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40.13 Remote Control - Scenarios - Sensitivity

Fig. 59 Sim Report form showing the Remote Control result

Sometimes you may want to run the simulation byngiveg one or several variables or
parameter values in the process several times. b be done manually but the Sim
Remote Control tool can be used to automate thid &f scenario or sensitivity analysis.

You may create a new Remote Control by selectingniéte, Create Remote-Control..."
from the Report form menu, Fig. 59. You may filltilee Remote sheet using the following
steps:

1.

The first step is to collect cell referencesramv 6. Locate the variable cell from the
calculation model, Fig. 48, and preSst Link on the Remote form, Fig. 59. You may
also type cell references manually, note that th& kame must be in brackets, [Unit 2],
and the sheet name must end with an exclamatiok, rDést!.

. Then click cells C5, D5, E5, etc. to specify tlagiable type SET/GET. The SET variable

sets the value and the GET variable reads the salN@te that the SET cell must contain
a value not a formulal

Fill in the SET values in the SET columns startirom row 7, and enter the number of
Rounds in column B. A large number of Rounds inses&ghe calculation time.

4. You may type some headers for rows 1 and 4fgustour own use.

5. Run the Remote Control by selecting "Remote, Remote-Control”, Fig. 59.

6. The Sim Remote control tool runs the simulatieweral times by changing the SET cells

by the given values and collects data in the GHuinons.

When the simulation has ended you may Save, RithCapy-Paste the results using normal
menu selections, Fig. 29. When you save the FleStfie Report.XLS file will automatically
be saved in the same folder.
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40.14 Creating Reports

Fig. 60 Sim Report form with a report on product streams.

Visualized graphical flowsheets are often the mitlsstrative way to report results.
However, sometimes some key figures are needeabuldr format. The HSC-Sim Report
dialog may be used to collect and modify the nexgsdata from the calculation models.
Using the selection “File, Report”, may open thimlt Please use the report sheet for
collecting results; the Balances, Streams and Resiutets are reserved for other purposes,
Fig. 60. Note that you may also insert other shigetgou own purposes.

You may pick up any data from the calculation mededing external links. You may type
these links in the Report sheet cells manuallyaar nay select the necessary cell from the
unit model (Set Link Source Cell) and then pregsSét Link button at the bottom of the
Report form. Please use the correct syntax in tkermal links. Formula: "=[Unit
2]Dist!G7" links the cell to cell G7 of the Dist-aét in Unit 2.

The green pattern of the cell means that the lind@bcontains no formula, which means
that you may type a new value in the Report sheetitawill be transferred into the source
cell too. i.e. green cells contain two-way bidiregal links. The yellow pattern means that
the source cell contains a formula, and this meaasway links cannot work with these
cells. The green two-way links allow you to charsgene process parameters quickly and
recalculate the process and collect new data igehew cells.

You may format the Report sheet in the same wayas format an Excel sheet. A
Report.XLS file is automatically saved in the saimder as the FLS process file when you
save the process.

Multiply Links may be used to link the same cells in each unthénReport sheet. For
example, select cells G6:G12 and press Multiplyk&in

TheShow Link button will show the source cell of the selectetbmal link. TheLinks ON
button may be used to set Links OFF in order teedpgp the calculations. THgalance
button calculates the element balances of the.units
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40.15 Global Cell Editor

Fig. 61 Global Cell Editor edits all units simultaneously

The Synch option at the bottom of the Model Editamm, Fig. 2, synchronizes all the

changes made to the variable list in the Input,pOuand Dist sheets columns A - D in all
units. However, sometimes you may want to make singnges in other sheets and cell
ranges too. The Global Cell Editor is made for ksl of work.

You can open Global Cell Editor by selecting: "TgoCell Editor...". This will open the
active cell for global editing. You may retype amyg in the Global Cell Editor text box and
when you press Enter it will be transferred touadits which have been selected in the unit
list at the right side of the dialog.

You may also move, insert and delete rows globalil selected units.

Please be very careful with this tool, you may lgadéstroy your models with this tool if
you are not absolutely sure of what you are doing.
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40.16 Calculation Model Appearance and Format

The row and column order of Input, Output, Distn@ols and partially also on the Model
sheet is fixed. However, the appearance and foraratgjuite free. In your own sheets the
layout and formats are totally free.

The default calculation model format may be setgishe file:
C:\HSC6\Template Model. XLS

You may edit the number, color, border, pattera, &irmats of this file using MS Excel. If
you want to return to the original formats thenetielthis file, it will be recreated if it does
not exist in the same folder as Sim.exe.

If you want to update old models using new tempfatenats then select: "Format, Unify
Using Template Model..." which will update the formaff all the units using the formats of
the "Template Model. XLS" file. You may also unifyy selecting "Format, Unify Using
Active Model...".

Fig. 61 Unit Unify Dialog.

You may also unify selected units only using therfat of the active unit. You may open the
Uniform Units dialog with the selection: "Tools, iinSheets...".
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40.17 Density of Aqueous Solutions

Fig. 62 Aqueous solution density calculator.

The HSC main database contains data of densitiegasés and condensed substances,
however, the densities of agueous solutions mustabmilated using the density calculator

and Aqueous Solution Density database, Fig. 62s Taiculator may be opened using the

"Tools, Density Calculator..." menu selection. Aquea@olution densities are needed, for

example, to convert analyzed concentrations in gitalquantities.

You may pick up agueous solution components froenligt on the right side of the form,
then the second step is to specify mass fractiodstemperature, then pressi@alculate
will give the results. The densities are based asanfractions because this type of
experimental data is available and the calculatradel uses this primary data. Aqueous
solution density is quite easy to measure expetiatign but difficult to evaluate
theoretically. You may add new data into AqueoulitBm Density.xls file using MS Excel.
See details of the basic ideas from chapter 40.17.1

These fixed density values may be used in HSC-Samed models. However, the
DensityA(Species;Amount;T) AddIin function may also be usedjive the densities as a
function of arguments in the models. DensityA usesctly the same calculation routine and
database as the aqueous solution density calcuktpr62. See example in:

C:\HSC6\AddInsAddInSample. XLS
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40.17.1 Density Calculation Methods

The density calculation for aqueous solutions waslenaccording to the article written by

M. Laliberté and E. Cooper. It is based on the nfesstions of the electrolytes in the

solution. The database includes constants for Bétrelytes and more constants can be
added to the database if measurements of the@olotian electrolyte are available.

In HSC Sim, the density calculation may be donegigixcel Add-In functiorDensityA.
For source information it needs the components:; thass fractions and the temperature of
the solution. The result is the density of the Botuin the unit kg/m

The Excel Add-in calculates first the apparent gmeeolume for each electrolyte and then
the density for the solution. The apparent speudicme is calculated with equation 1.

1 Wy ©C Gt

appi 0000001t ¢, 2
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)

The apparent specific volume can be either posdgiveegative. Typically it has a low value
at low concentration and then increases towarcheati relationship with mass fraction at
higher concentration. The density of the solutian be calculated from the volume with the
following equation:

m )
WH 20
VVi Vapp,i
H20

40.17.2 Adding new electrolytes to the database

To add new electrolytes to the database the cdsstano c, have to be calculated.
Calculation is preformed with similar equations @&sented above. First, the apparent
specific volume is calculated from the measuremetits the following equation:

ml W

1
H,0

Vapp,i —W (3)

m=7

The volume is used to calculate the constaste c,. Equation 1 is used in this calculation
and it reduces to equation 4 for a solution of aret electrolyte in the water.

y W, C, Cgt

appi 2 (
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The calculations of the constants were made withlimear least-squares method (Excel
solver) when the initial guesses for constaaisto ¢, were 1, 1, 1, 0.0025 and 1500
respectively. Then new values for the volume arel diensity were calculated with the
equations 1 and 2. Residuals were calculated byasiimg the calculated apparent specific
volume and solution density from their experimentalues. The sum of the square of the
density residuals was calculated, and this valug mvanimized varying the constants. The
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data was also checked for consistency for bothmeland density, by calculating average
residuals and standard deviations. If a data panes 4 times the standard deviation from
the average residual, the data point is removedl@ndalculation is repeated until there are
no inconsistent data. Because the constaman sometimes be negative the other initial
guess for it was -1500 to avoid convergence prablem

Calculation spreadsheets from the source artideagailable free of charge via the Internet
at http://pubs.acs.org.

40.17.3 List of symbols

Co Empirical constant, ngrn

C Empirical constant, kgﬁ'n

C Empirical constant, -

Cs Empirical constant, (0

Cs Empirical constant, C

t Temperature, C

Vapp,| Apparent specific volume of component i, %k

Wh20 Mass fraction of the water, -

W Mass fraction of component i, -
H20 Density of the water, kgfm

m Density of the mixture, kgfn
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40.19 Password Protection of Units

Fig. 63 Password protection dialog.

You may hide the calculation models of the prod®sselecting from the Flowsheet menu:
"File, Lock Excel Units with Password..." Dialog, deig. 63:

Type the password to the Password column and pBesee Password to All
Press théock button.

Press th&ave Proces$utton.

Press th€losebutton.

P wn e

This procedure will hide all the other sheets thgut and Outputsheets and save unit files
in a crypted format which cannot be opened withdExt any other program. You may also
password-protect only one unit by giving the passvamly to this unit.

You may open the password protection if you knoe gassword but press the Unlock
button instead of the Lock button.

Note that password protection automatically opdres dells with external references for
monitoring and calculations, but all the other £eh the hidden sheets are invisible for the
external references. All the "open”, unprotectets @re marked witlyreen pattern on the
hidden sheets.

The password-protected units are like black-bowdmere only the Input- and Output-sheets
are visible to the user. However, remember thatwthe final user has full access to the
protected files in his hard disk, then any protstinethod is NOT absolutely safe.
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40.18 Data Reconciliation
Data reconciliation means fitting the analyseshef $streams to solve the mass flow of each
stream and recalculating the analyses so thatdiwslieet is internally consistent.
For that you need:
o Chemical analyses of the streams, weight baseayt.%, ppm, g/t, ppb etc.
o0 Knowledge of the analysis variation for each elemen

The steps of data reconciliation are:

1. Drawing the flowsheet and naming the streams
Inputting analyses

Creating mass balance equations

Solving the mass flows and assays

Saving the balanced result for further use

a bk wnn

Inputting analyses:

Analyses are imported into the Analysis.xIs fildhigh is stored in the same folder as the
flowsheet.

Steps for inputting the analyses are:

1. Open the Analysis window from the flowsheetesellools — Analyses
2. Prepare the analyses in Excel or somewhereretséormat where:
0 Row-wise data: Each sample is in its own row

o0 The name of the sample is the same as the streaumc@n check and change that
later)

o0 Each analyzed element in its own column

0 Header data in one row, include there analyzed oo, analysis method and
unit, e.g. Cr203 XRF %, Cu TOT ppm, Au (FA) g/,

o0 Name the first column where the stream name iSt&eam’

0 Above and on the left side of the ‘Stream’ cell yoay have data which is not taken
into account in data reconciliation

3. Note that you do not need to have the analySeaah stream. There may be also some
extra samples. These are omitted in data recotmoiliabut if you like you can have
them there for information or some other purpose.

4. One stream cannot appear twice!
5. Import the analyses into the Analysis windowhei by opening the file (File — Open)
or through the clipboard (Edit — Paste)

At this moment the analysis data should look like {Fig. 64):
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Fig. 64 Analyses. Data has to be row-wise, “Stream” itelicates the top left corner of the
analysis table. Analyses are as follows: prefeadigtgive the element, method and unit; all
in a single cell.

6. Press the “Identify Streams” button, which atlts columns Source, Destination and
Mass% if required next to the ‘Stream’ column aifid it accordingly (Fig. 64). Check
that the streams have the correct ‘Source’ andtiDeson’. A question mark denotes
that it is either a feed or product stream of tineud. If ‘Source’ and ‘Destination’ are
empty, then the sample has not been identifiedtla@dame of the stream is incorrect
either in the flowsheet or analysis listing. Changeeither place and redo ‘ldentify
Streams’. This listing is regenerated each time gr@ss the “Identify Streams” button.
You can change the stream names and other datellas w
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Fig. 65 After pressing ‘Identify Streams’ button the ‘Soe’ and ‘Destination’ columns
appear in the spreadsheet. A question mark (atek that the stream is either an input (in
‘Source’ column) or output (in ‘Destination’ column

7. SelectFile — Saveto save the data in the same folder as the flogisliAnalyses.xIs)
Once saved, the analyses will be loaded autombtieEch time you open the
flowsheet.

Data Reconciliation:

The data reconciliation can be done once you hawet ithe data and identified the streams.
Press the “Data Reconciliation >>>>" button in th&nalysis’ window. The data
reconciliation window opens, see below. The windoensists of five parts: 1) stream
control at the top, 2) analysis control on the tid) unit control below in the middle, 4)
options on the right, 5) mass balance info box@nouttons at the bottom.

The starting point of the data reconciliation she¢hat :
o All the units and streams are selected for the dat@nciliation
o All elements are selected for the data reconalmtind the coefficient of variation,
CV, aresetto 1l

0 Mass balance equations are generated accordingptgsas. This means that while
the mass balance equation is written initially &runits, in the second step the unit
size is enlarged in a way that mass balance eaqsatice fulfilled according to the
analyzed samples. This means that the number of baance equations is reduced
and some streams with analyses may be left outusectheir mass proportion
cannot be calculated directly by mass balancing.

The steps of the data reconciliation are:

1. You may start by pressing the “Reconcile !I" batend see what is the outcome of the
basic assumption.

2. To do the reconciliation for only part of thevisheet e.g. in cases where some of the
streams tend to end up negative, use “Is Used™Andlysis” columns.

o “X” indicates that the stream is selected. Clicle ttell and the stream switches
between selected (“X”) and unselected (* “).

0 “Is Used”: if you unselect the stream in the “Ised’ column this equals the cases
where the stream does not exist at all

0 “Analysis”: if you unselect the stream in the “Apsis” column this equals the case
where the stream has not been analyzed

0 Check the mass balance equations in use at thenboftthe window

3. Click on the cell or use the Edit menu to undedsd select “Is used” and “Analysis”.
Note that there is an option to select the streama unit. Select the unit in the
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flowsheet and then select from the menu “Is Uselldd selected unit”. This changes
the input and output streams of the unit as “IsdJse

Analysis control

Stream control

Options

Mass balanc
equation info box

Buttons

Fig. 66. Data Reconciliation window.

4.

By fine-tuning the weighting of analyses: on thght side of the window in “Analysis
control” you can fine-tune the effect of each asalyAgain “X” means that analysis of
e.g. copper is taken into data reconciliation whiléur can be excluded.

CV, the coefficient of variation: the weightinfithe analysis is adjusted on the basis of
the coefficient of variation. A low CV value, e., means that the analysis is highly
reliable whereas a high value, >10, is used fordoauracy and low reliability. In mass
balancing the analyses are changed according to thermula:
used=analyzed/(CV*content_in_feed).
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6. If you cannot get rid of negative values, switchthe NNLS (non-negative least
squares) method. Be careful that, there may be edwong wrong with the original
analyses; and a better way could be to uncheclptblelematic streams (“Analysis”-

column).

Fig. 67. Result of the data Reconciliation in the Sim Répondow.

7. Once you are happy with the results as showhearReport window you can save the
output back in the Analysis.xls file. To do thatese from the reconciliation window
menu ‘Results’ — ‘Write into Analyses’ (Fig. 68).9& Sim asks for the name of the
sheet for the output (Balanced as default). Ifaesl not exist, a new sheet will be
created and reconciled data will be written thHrene exists, the sheet will be emptied

and replaced with the new data.

Fig. 68: Writing the result back in the Analysis window.
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8. To complete the data in the ‘Balanced’ sheahe‘Analysis’ window, press ‘Identify
streams’ and select from the menu ‘Tools’ — ‘Cadtell Recoveries’. Recoveries are
calculated against the first row (Fig. 69). To stheeresult select File — Save (Fig. 69).

Fig. 69 Balanced result as complete in the ‘Balancedetshéth ‘Source’ and ‘Destination’
information (by pressing ‘ldentify Streams’) andogeries (by selecting Tools — Calculate
Recoveries). Save the data by selecting ‘File’avts...".



